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viii Photoshop Tricks for Designers

(1) Who should have this book?
This book was designed to be a quick-access 
handbook, mainly for working designers and 
artists, but that doesn’t mean that photogra-
phers or even hobbyists can’t get something 
out of these pages either. Whether you need 
quick instruction or even just a little inspira-
tion, this book is for you!

(2) �What is the user level of  
this book?

This book assumes an intermediate or 
higher-level user—especially later in the 
book when you get to the Hollywood-style 
and 3D chapters. But, that does not mean 
it excludes beginners. The exercises are 
easy to follow along with for newbies, if 
you are patient with the steps, but it helps 
to at least have a good foundation of how 
Photoshop works.

(3) �What about the fonts used  
in this book?

The fonts used in this book, in many cases, 
are the default fonts that are part of your 
OS. However, quite a few are from Adobe 
Typekit, which is a font service that is part 
of Adobe’s Creative Cloud and allows you 
to sync fonts to your desktop applications. 
This service is only available to full Creative 
Cloud subscribers.

(4) �What version of Photoshop  
do I need for this book?

The exercises in this book were created in 
Photoshop CC 2015. If you are using an 
older version of Photoshop, I first have to 
ask, why? I am kidding. Though, seriously, a 
lot of the techniques within this book can be 
done in some older versions of Photoshop, 
but if you are a Creative Cloud subscriber, 
you should have the newest version anyway.

(5) What about exercise downloads?
You can follow along with the projects by 
downloading low-res versions of the same 
image files used in the book. This way 
you can make sure you understand the 
techniques, so you can then apply them 
to your own projects. You can download 
these files over at kelbyone.com/books 
/psdesignbook.

Seven Questions & Answers About This Book
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(6) �How about the use of  
stock images?

While in some cases I use images I have 
shot with my camera or my phone, I have 
always been a big proponent of using stock 
images. Throughout this book, I utilize a lot 
of stock images from Adobe Stock (former-
ly Fotolia.com). This is a fantastic resource 
and the best part is that it is built right into 
the Creative Cloud, though it is a separately 
priced service. When you sign up, you get 
10 free images, and you can download wa-
termarked comps of any image. 

(7) What about other resources?
In addition to Adobe Stock, there are a few 
other resources I use that I wanted you to 
be aware of. While these are not resources 
I have used in this book, they’re ones I do 
use occasionally and, as a designer, you can 
never have too much.

PixelSquid.com: The folks at TurboSquid 
.com have created a resource for 3D objects 
developed specifically for Photoshop. How-
ever, they do not use Photoshop 3D in the 
normal sense. You use a special plug-in to 
import the 3D objects into your Photoshop 
designs. You can control the angle of an 
object, but only in the plug-in window. As 
of this writing, this service is free but that 
may change. It’s an impressive resource.

DaFont.com: While Typekit is a robust and 
user-friendly font library, I will still go to 
Dafont.com for more stylized and unusual 
fonts. These fonts are free, but be aware of 
the usage rights for each font.

Archive3D.net: Photoshop’s ability to cre-
ate 3D objects and effects from scratch is 
really impressive, but you can also import 3D 
objects created in other applications. One 
resource I use is Archive3D.net. They have 
a lot of cool 3D models that you can import  
into Photoshop, and they are all free. Be 
warned though, they don’t always work 
when you import them into Photoshop. In 
most cases, they work fine but sometimes 
they come in exploded or missing parts. 
They can be adjusted, but sometimes they 
are just hopeless, but that’s the risk you take 
when it’s free.
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The Photoshop for Designers Book

Type Effects
Working with type is an essential skill for a designer, and now Photoshop 

allows you to do more with type than you ever thought possible. In this 

chapter, you’ll learn a few tricks that will help you think a little more 

creatively about text as a design element.
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Stone Age Text
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EThis effect was inspired by the movie  
Jurassic World. It’s a cool way of using a 
single texture and layer styles to get an  
interesting result.

STEP ONE: Start by pressing Command-O 
(PC: Ctrl-O) and opening the texture image 
you want to use as your base. You can ei-
ther use your own or you can download 
the texture used in this exercise from the 
book’s downloads page, mentioned in the 
book’s introduction.

STEP TWO: Once the file is open, go to the 
Edit menu and choose Define Pattern. 
When prompted, give the new pattern a 
name and click OK.

STEP THREE: Next, press Command-N (PC: 
Ctrl-N) to create a new document measur-
ing 2000 pixels wide by 1000 pixels tall. 
Click on the Background Contents color 
swatch and set the color to Black, then 
click OK.

STEP FOUR: Now, select the Horizontal Type 
tool (T), press D, then X to set your Fore-
ground color to white, and click on the 
canvas to set a new text layer. Choose a 
thick font in a fairly large size to show as 
much of the texture as you can. Here, I am 
using a font called BT Machine. Use the 
Character panel to adjust the text to your 
liking (I kerned the second word to match 
the width of the first).

STEP FIVE: With the text layer selected, click 
on the Add a Layer Style icon at the bottom 
of the Layers panel and choose Pattern 
Overlay. Click on the Pattern thumbnail, 
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locate the texture you defined in Step Two 
(it should be the last one), and click on it 
to select it. Once you select the texture, 
you can position it in the text manually by 
clicking on the image and dragging around. 
Click OK when you’re done.

STEP SIX: Make a duplicate of this layer by 
pressing Command-J (PC: Ctrl-J).

STEP SEVEN: Double-click on the layer style 
name below this duplicate layer in the Lay-
ers panel to reopen the Layer Style dialog, 
and add a Bevel & Emboss layer style to the 
existing Pattern Overlay. Use the settings  
I have here to give the text a chiseled look. 
Click OK.

STEP EIGHT: Now, click on the Add Layer 
Mask icon at the bottom of the Layers 
panel to add a mask to this duplicate text 
layer. Then, choose the Brush tool (B) in the 
Toolbox. In the Brush Picker in the Options 
Bar, choose a simple spatter brush like the 
one shown below, which is part of the de-
fault brush set. Click the folder icon to the 
right of the brush thumbnail to open the 
Brush panel, and under Brush Tip Shape, 
set the Spacing to around 50%. Turn on 
the Shape Dynamics checkbox, and set the 
Size and Roundness Jitters to 0 and the 
Angle Jitter to 100%. (Note: Make sure 
the Pen Pressure icon in the Options Bar 
is off, so you control pen pressure in the 
Brush panel.)
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STEP NINE: Make sure your Foreground color 
is set to black, then with the layer mask ac-
tive, dab on the image in just a few random 
areas of the text to get a chiseled look as 
it redraws the bevel (you’re masking away 
the small areas where you’re painting). Be 
sure not to overdo it.

STEP 10: Next, click on the Create a New 
Layer icon at the bottom of the Layers panel 
to create a blank layer above the text layers. 
Press-and-hold the Option (PC: Alt) key as 
you click on the ƒx icon on the layer below 
and drag-and-drop it onto the blank layer 
above. This will copy the layer style to your 
blank layer.

STEP 11: Now, using a cool particle brush, 
we’ll add dust and debris falling off the 
text. We look at creating brush effects in 
Chapter 5, but you can download these 
brush presets to use here from the book’s 
downloads page, mentioned in the book’s 
introduction (double-click on the file and 
it will appear in your Tool Presets panel, as 
well as your Brush options panel, ready to be 
used). Just dab around the chipped areas of 
the text to add the falling particles. 
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Final

STEP 12: As a final touch, make sure your 
Foreground color is still set to black and 
make a duplicate of the Background layer. 
Then, apply the same stone texture as a 
Pattern Overlay layer style to this layer for a 
background element. However, in the Layer  
Style dialog, drop the Opacity to 75%. 
Then, click on Gradient Overlay on the left, 
and set the Blend Mode to Multiply and the 
Opacity to 75%. Choose the Foreground to 
Background gradient in the Gradient Pick-
er, set the Style to Radial, and turn on the 
Reverse checkbox, then increase the Scale 
to 115%. You can manually position the 
gradient by clicking-and-dragging directly 
on the image.

STEP 13: Finally, go back to the original text 
layer that just has the texture, and apply 
a Drop Shadow layer style to give it some 
dimension against the backdrop. As a final 
option, you can add a Color Overlay layer 
style to the beveled layer to create more 
separation, as I did here (I chose an orange 
color, set the Blend Mode to Overlay, and 
lowered the Opacity to 50%).
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Highlighted Text Overlay
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A common design feature these days is  
a text overlay blended with a background 
photo in a stylish way. Here we will create 
a sports-themed poster, but you can theme 
it to just about anything.

STEP ONE: Press Command-O (PC: Ctrl-O) 
to start by opening the shot you want to 
use as your base image. Here, I am going 
with a sports theme by doing a basketball 
poster. You can download this file from  
the book’s downloads page, mentioned in 
the book’s introduction, or use any image 
you want. This technique works on just 
about anything.

STEP TWO: Press Command-N (PC: Ctrl-N) 
to open the New dialog, and create a new 
document that is 1200 pixels wide by 1700 
pixels tall, with the Background Contents 
set to White. Use the Move tool (V) to 
drag-and-drop the base image onto this 
new document. Press Command-T (PC: 
Ctrl-T) to go into Free Transform, and scale 
and rotate the image into its final position, 
then press Return (PC: Enter) to commit  
the changes.

STEP THREE: Now, to a get a quick, gritty look 
on this sports photo, just make a duplicate 
of the layer by pressing Command-J (PC: 
Ctrl-J), then go under the Filter menu, un-
der Other, and choose High Pass. Set the 
Radius to 10 pixels and click OK.
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STEP FOUR: Change the blend mode of this 
high pass layer to Overlay. This will sharpen 
and enhance the contrast of the subject.

STEP EIGHT: Select the original photo layer  
in the Layers panel and drop its Opacity  
to 55%.

STEP FIVE: Next, we are going to colorize the 
image using a Black & White adjustment 
layer. Oh yeah, you heard me right. With 
the topmost layer selected, click on the 
Create New Adjustment Layer icon at the 
bottom of the Layers panel, and choose 
Black & White.

STEP SIX: In the Properties panel, turn on the 
Tint checkbox at the top, then click on the 
swatch to the right to open the Color Pick-
er. Choose a color for the base background 
and click OK. Here, I am using a gold color 
(R=174, G=127, B=15). Remember, it is an 
adjustment layer, so you can change this  
at any time.

STEP SEVEN: Once you choose the tint color, 
using the various color sliders below, you 
can adjust the intensity of the color by color 
ranges in the image. For instance, increasing 
the Reds amount will make the shadow  
areas lighter, thus making the tint color 
show more. You can continue to adjust the 
other sliders where needed until the image 
is to your liking.
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STEP NINE: Go under the View menu and 
choose New Guide Layout. Turn off the 
Columns checkbox, and turn on the Mar-
gin checkbox, then set all sides to 100 px. 
Click OK.

STEP 10: Grab the Horizontal Type tool (T) in 
the Toolbox. Then, click on the top left mar-
gin corner and drag out a text box inside 
the margin guides. Choose a font in the 
Options Bar (I used Futura Medium), then 
set the text to fit the theme. I typed “BAS-
KETBALL” but split the word onto three 
lines, changing the font size and kerning 
to make it fit evenly, as you see here.

STEP 11: Highlight the first line of text, then 
press-and-hold Command-Option-Shift (PC:  
Ctrl-Alt-Shift) and press the period key re-
peatedly, until the last letter jumps to the 
next line, then go back one step by pressing 
the comma key. Do this to the remaining 
lines to fill the width of the box with the text. 
Adjust the leading in the Character panel, 
if necessary (I adjusted it so the lines were 
close, but not touching).

STEP 12: Double-click the text layer’s thumb-
nail to select the text. Then, go to the Options 
Bar and click on the color swatch to open the 
Color Picker. Here, I am using this bright 
magenta red color since my background is 
yellow. You may need to experiment with 
other colors if using a different color back-
ground. Click OK when done.
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STEP 13: Now just change the text layer’s 
blend mode to Difference, and this will 
result in an interesting color mix with the 
background. Finally, as an option, you can 
add a subtle Drop Shadow layer style to 
the text layer to create a sense of depth, as 
you see here. Also, if you change the tint 
color in the adjustment layer, you will see 
various interesting results with the way it 
is all blending.
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Another Layer Style Texture Trick

Here is a rather cool trick for combining 
styles and textures while still being able to 
keep all the elements on separate layers. 
This is yet another reason why mastering 
layers is key to using Photoshop.

STEP ONE: This effect is similar to the stone 
texture effect earlier in this chapter but with 
a little twist to it. It is a pretty cool trick for 
being able to have complex effects while 
maintaining full editability of the original 
text layer. Start by pressing Command-O 
(PC: Ctrl-O) and opening the texture file 
you want to use. Here, we have an inter-
esting rust texture.

STEP TWO: Define this texture as a pattern 
by going under the Edit menu and choos-
ing Define Pattern. Name the texture when 
prompted. Click OK.

STEP THREE: Press Command-N (PC: Ctrl-N) 
to create a new document measuring 2000 
pixels wide by 1000 pixels tall, with the 
Background Contents set to Black. Now, 
select the Horizontal Type tool (T) in the 
Toolbox, click in your document to set a 
new text layer, and type some text. Here,  
I typed a simple, bold, two-word title. Be sure 
to use a really thick font for this (I used a 
font called Swiss Black), and use the Char-
acter panel to adjust the text to your liking  
(I kerned it and adjusted the leading).

STEP FOUR: Once the text is set, go to the 
Layers panel and add a new blank layer 
above or below the text layer (I added mine 
below by Command-clicking [PC: Ctrl-click-
ing] on the Create a New Layer icon at the 
bottom of the panel).

STEP FIVE: Now, Command-click (PC: Ctrl-
click) on both the text layer and the blank 
layer to select them, and press Command-G 
(PC: Ctrl-G) to group them in a folder (the 
layers are still separate, but just nested in 
this group). The cool thing about this is we 
can apply a layer style to the group and it 
will see the layers as one, even though they 
are separate. 

STEP SIX: With the group folder selected, 
click on the Add a Layer Style icon at the 
bottom of the Layers panel, and choose Pat-
tern Overlay. Click on the Pattern thumbnail 
and choose the texture you defined in Step 
Two (it should be the last one). Remember, 
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you can adjust the position of the texture 
manually by clicking-and-dragging directly 
on the image. Don’t click OK yet.

STEP SEVEN: Click on Bevel & Emboss on 
the left and use settings similar to what  
I have below to give the text some dimen-
sion on the edges. The bevel will become 
more pronounced in a minute.

STEP EIGHT: Okay, remember that blank 
layer? Click on the small arrow to the left 
of the group folder in the Layers panel to 
reveal the layers in the group. Then, click on 
the blank layer to select it.

STEP NINE: Now you just want to introduce 
some graphic element on this layer and it 
will blend with the text via the layer style 
applied to the group. For instance, here  
I used the Brush tool (B) with a brush made 
from a splash of water (we look at creating 
brush effects a couple times in this book, but 
you can download the brush I used here from 
the book’s companion webpage). If you just 
dab the brush a couple times around the 
text, it immediately gives you something in-
teresting. So, press D to set your Foreground 
color to black, and click a few times around 
the text. Notice how the texture is revealed 
where the new elements appear. Doing it 
this way, you have more control over the 
placement of the text and other elements 
because they are still on separate layers; 
they are just in a group. Cool, huh?

Final




